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Disclaimer 

Disclaimer of liability and conditions of use 

1. To the extent permitted by law: 

(a) the Commonwealth of Australia and the Productivity Commission (the Agencies) give no 
warranty of any type, either express or implied, for MoDEM (the Program), and any 
other material supplied with the Program; and  

(b) the entire risk of loss, damage or unsatisfactory performance of the Program (no matter 
how arising, including as a result of negligence on behalf of the Agencies) rests with the 
user (the User). In no event will the Agencies be liable for damages, including any 
general, special, incidental or consequential damages, arising out of the installation of 
the Program, any attempt to install the Program, the use of the Program, the inability to 
use the Program, the use of data embodied in, or obtained from, the Program or the use 
of any documentation or other material accompanying the Program. 

2. The numerical data and formulas contained in the Program are provided solely for the 
purpose of illustrating the modelling framework for projecting possible outcomes under 
different demographic and economic scenarios. The Agencies give no warranty and make 
no representation as to the accuracy, reliability, timeliness or other features of any data 
contained in the Program or data obtained from using the Program. In particular: 

(a) the User should rely on the User’s own inquiries as to the accuracy and relevance of the 
data incorporated into or applicable to the Program; 

(b) the User should not use the Program as the basis for making any decision or embarking 
on any course of action; and 

(c) the data contained in the Program and the output of the Program should not be 
regarded as representative of any current data or forecasts of what will happen under a 
given set of demographic and economic conditions.  

3. The Program is based on input (parameters and projections) from data published by the 
Australian Bureau of Statistics. From time to time the ABS may publish updated data which 
may be relevant to the Program. Users should rely on their own inquiries in relation to the 
accuracy and relevance of any available data and its appropriateness for updating the 
Program. The Agencies have provided some guidance as to the manner of inputting updated 
data into the Program in the Documentation, however, the Agencies accept no responsibility 
for errors in the input data, the lack of currency of the input data, any problems experienced 
by the user in updating or attempting to update the input data, or the results obtained from 
running the Program using the updated data. 

(Continued next page)  
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Disclaimer of liability and conditions of use  (continued)

4. If you have obtained this Program otherwise than by downloading it from the Productivity 
Commission’s website, the Program may have been modified by a previous user. The 
Agencies accept no liability in relation to modifications made by any user. 

5. The intellectual property in this Program is and remains the property of the Agencies.  

6. The Program is made available to Users for their own use and may be provided or re-
disseminated by them to another party. The User who re-disseminates the Program should 
include the disclaimer and conditions of use in its current form with the Program, and identify 
any modifications made by the User to the Program and Documentation. 

7. The User may modify the Program. However, the Productivity Commission would appreciate 
being informed of any modifications made by the User and being offered the opportunity to 
add any extra data and modifications to its own version of the Program. When making 
modifications of the Program available to the Commission, please also identify who created 
the material contained in the modifications. 

8. Users who have obtained the Program from a person other than the Productivity 
Commission are still bound by these conditions of use. The Agencies recommend that Users 
go to the Productivity Commission’s website at www.pc.gov.au to download the original 
version of the Program.  
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Abbreviations  

ABS Australian Bureau of Statistics 

ASFR Age Specific Fertility Rate 

CBR Crude Birth Rate 

CDR Crude Death Rate 

CSV comma-separated value 

ERP Estimated resident population 

GDP Gross Domestic Product 

GIF Graphics Interchange Format 

GRR Gross Reproduction Rate 

MoDEM Modified Demographic and Economic Model 

NOM net overseas migration 

PC Productivity Commission 

TFR Total Fertility Rate 

VBA Visual Basic for Applications 
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1 Introduction to MoDEM 2.0 

The Modified Demographic and Economic Model (MoDEM) 2.0 is used to 
calculate population, labour market and Gross Domestic Product (GDP) projections 
under different demographic and labour assumptions. Key model outputs include 
population size, dependency ratios, labour force participation rates, GDP and GDP 
per capita. The model allows two sets of projections to be compared to evaluate the 
effects of a change in assumptions. 

MoDEM 2.0 has its origins in a model created for the Productivity Commission 
(PC) report on Economic Implications of an Ageing Australia (PC 2005). That 
model was subsequently modified for the report on Potential Benefits of the 
National Reform Agenda (PC 2007). This became MoDEM 1.0, released in late 
2007. MoDEM has now been upgraded to include a user-friendly interface and the 
ability to update the input data and change the base year of projections, among other 
features. The base year has been updated to 2007 and the labour parameters have 
been re-estimated.  

MoDEM’s flexibility and ease of use makes it suitable for a wide range of users and 
applications. For example: 

• Demographers can use the model to manage multiple demographic projections at 
once, and to incorporate the labour market implications of demographic changes; 

• Government departments and agencies can use the model to assess the effects of 
medium- and long-term policies on population and labour supply, as well as to 
explore the interaction of demography and labour market outcomes; 

• Academics, researchers and others can use MoDEM to investigate research 
questions related to demography, labour market outcomes and economic growth. 

MoDEM accommodates users with different levels of experience and different 
requirements. Users can select from two modes of use (Interface Mode and Expert 
Mode) and can choose to use the basic modules (Detailed Projection module and 
Results module) or additional modules (Projection Wizard, Export/Import, Update 
module, and Labour Supply Shocks). 
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1.1 MoDEM modes 

The two modes of use are Interface Mode and Expert Mode. Interface Mode is 
suitable for new and less experienced users, and for those who do not need to access 
to the underlying formulas and databases in the model. This mode features a 
graphical interface, step-by-step instructions, navigation buttons and drop-down 
menus. Expert Mode enables more experienced users to view and make changes to 
the full databases, Excel formulas and Visual Basic for Applications (VBA) code in 
MoDEM 2.0. This mode restores the full Excel Toolbar, Formula bar, row and 
column headers and Excel worksheet tabs. 

1.2 Basic MoDEM modules 

The basic MoDEM modules are the Detailed Projection module and Results 
module. These are suitable for both new and experienced users who wish to create 
scenarios and view projected outputs. The Detailed Projection module takes users 
through a series of steps to create a scenario from preset options or by entering their 
own data. The Results module allows users to view the demographic and economic 
projections resulting from the active scenario. 

An invaluable feature that complements the basic modules is the Scenario Summary 
sheet. This provides a complete summary of the settings in the active scenario, and 
allows users to save or modify the scenario, restore the default or imported scenario, 
or view the projection results (Results module). 

1.3 Additional MoDEM modules 

In addition to the basic MoDEM modules, users can access four additional modules: 
the Projection Wizard, Export/Import module, Update module, and Labour Supply 
Shocks module. 

The Projection Wizard is suitable for the experienced user who is familiar with the 
steps involved in creating a MoDEM scenario, requires minimal instruction in doing 
so, and does not need to view the underlying data for each parameter. It allows the 
user to quickly enter the necessary assumptions to create a scenario. 

An Export/Import module is suitable for both new and experienced users who wish 
to save scenarios to access at a later stage or to share with other users. A simple-to-
use feature, it allows users to save the active scenario as a separate file and to load 
other pre-saved scenarios. 
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Update module is best suited to more experienced users who wish to change the 
base year for projections or update the model with new data. 

The Labour Supply Shocks module is best suited to more experienced users who 
wish to assess the effect of policy changes that ‘shock’ labour force participation, 
unemployment, hours worked and productivity. Users enter the labour supply 
shocks after creating a scenario using the Detailed Projection module (or using the 
Projection Wizard, or importing a scenario using Export/Import). 

This manual contains detailed instructions for using MoDEM 2.0:  

• Chapter 2 describes how to get started using MoDEM, including opening and 
navigating around the model.  

• Chapters 3 to 8 explain how to use the basic MoDEM modules to create a 
scenario and view projection results, and how to use the additional MoDEM 
modules. 

• Chapter 9 describes how to use MoDEM in Expert Mode, and provides some 
tips for expert users. 

• Appendices A to D contain miscellaneous information about MoDEM 2.0. 
Appendix A discusses error testing; Appendix B defines key demographic and 
economic terminology; Appendix C describes the assumptions underpinning the 
default (‘Medium’) MoDEM scenario; and Appendix D describes the functions 
of and relationships between all the Excel worksheets in MoDEM. 
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2 Getting started with MoDEM 2.0 

MoDEM 2.0 is an excel module written using Excel’s built-in functions and with 
Visual Basic for Applications (VBA). The interface has been designed to  

• increase the ease of use of MoDEM 

• add flexibility in the choice of selected parameters 

• enable MoDEM to be easily updated with new base data (changing the base 
year) or by updating any of the selected parameters. 

2.1 Opening MoDEM 

MoDEM is opened by double clicking on the icon, or choosing File → Open from 
the Excel toolbar. To allow MoDEM to load, Macros must be enabled. Due to the 
size of the file (approximately 70Mb) and the launch of interface macros, the 
program will take a few seconds to load. 

The objects, fonts and graphics in MoDEM have been set to a standard size. Users 
can change the screen resolution to aid readability, if desired, by clicking on 
View → Zoom and choosing an appropriate screen magnification. 

2.2 Navigating around MoDEM 

By default, MoDEM 2.0 will open in Interface Mode. (Chapter 9 provides 
information on switching to and using Expert Mode.) All Excel worksheet tabs, as 
well as toolbars and the formula bar, are hidden in Interface Mode. As a 
consequence, users must navigate around MoDEM in one of two ways: using 
screen-based menus and buttons (beginning with the MoDEM Main Menu) and 
using the MoDEM Menu Bar. 

The MoDEM Main Menu 

Navigation using buttons in the Main Menu and subsequent screens is ideal for new 
or inexperienced MoDEM 2.0 users, as each menu and sub-menu offers instructions 
on choosing from the options listed.  
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With this navigation method, users begin by selecting one of the modules or 
features listed in the MoDEM Main Menu screen, clicking the ‘Launch’ button next 
to the selected feature. This takes the user either directly to the selected option, or to 
a sub-menu. 

From the MoDEM Main Menu, the following options are available: 

• Projections 

– Detailed Projection 

L Leads directly to step 1 of the 16-step Detailed Projection module, which 
guides users through creating a scenario. 

– Labour Supply Shocks 

L Leads to the Labour Supply Shocks sub-menu, from which the user can 
navigate to one of up to three shock scenarios, as well as choose from a 
range of related options in this module.  

– Scenario Summary 

L Leads directly to a summary of all settings in the active scenario. 

– Results 

L Leads to the Results sub-menu, from which the user can navigate to a 
range of demographic and economic projection results, in tables and 
graphs. 

• Database 

– MoDEM Update 

L Leads to the Update sub-menu, from which the user can navigate to a 
range of sub-modules that update different parameters (such as the base 
year, fertility and mortality data, and so on). 

• Exporting, Importing and Expert Options 

– Export/Import Scenario 

L Leads to the Export/Import sub-menu, from which the user can choose to 
export (save) the active scenario, or import (open) a previously saved 
MoDEM scenario. 

– MoDEM Expert Mode 

L Switches MoDEM to Expert Mode, showing all Excel toolbars, the 
formula bar, worksheet tabs, and row and column headers. 
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– Projection Wizard 

L Leads directly to step 1 of the Projection Wizard, which allows users to 
quickly select options for the Detailed Projection module without viewing 
the details of each parameter. 

– MoDEM Close 

L Exits MoDEM 2.0. Users are prompted to save the MoDEM workbook 
before closing Excel. However, this process does not create separate 
export files for any scenarios. 

The MoDEM Menu Bar 

Alternatively, the MoDEM Menu Bar allows users to directly access a desired 
screen. For example, users can navigate directly from the ‘Survival’ screen in the 
Detailed Projection module to the ‘Resident Population’ screen in the Results 
module. 

The MoDEM Menu Bar loads automatically when MoDEM opens. In Excel 2003, 
the MoDEM Menu Bar is found directly on the toolbar, next to the Excel Window 
Menu. In Excel 2007, the Menu Bar is on the ‘Quick Access Toolbar’ under Menu 
Commands. 

Of course, users can navigate around MoDEM with a combination of the Menu Bar 
and Main Menu (button) methods. 

As well as the options listed in the Main Menu, the MoDEM Menu Bar offers the 
following additional options: 

• About 

– This form lists basic information about MoDEM, the user interface and the 
individuals involved in its development. 

• Terms and Conditions 

– Although MoDEM is considered shareware, users are bound by a set of 
conditions. This form details the disclaimer of liability and conditions of use. 

• Set as Baseline 

– This sets the active scenario as the ‘baseline’ scenario. Users can then create 
a new scenario and compare this with the baseline scenario. 

– Note: this option is also available in Main Menu navigation, when users reach 
the last step of the Detailed Projection module or of the Projection Wizard. 
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• Help 

– This launches a form showing an index of help topics. Choosing a help topic 
opens the MoDEM Manual (this document) at the selected topic. 

Restoring Toolbars 

When MoDEM loads in interface mode, the default Excel toolbars are deleted to 
keep the interface as simple and uncluttered as possible. However, the toolbars are 
restored once the user closes MoDEM. Toolbars can be reactivated in MoDEM in 
two ways. First, the user can enter Expert Mode (see chapter 9), which will restore 
the toolbars, as well as the formula bar and any hidden sheets. Second, the user can 
manually add toolbars by using the View → Toolbars option on the Excel Toolbar. 
To manually restore the formula bar, select Tools → Options and tick the ‘Formula 
Bar’ option. 

2.3 Getting help in MoDEM 

The MoDEM Manual (this document) is the main source of help and instructions 
for MoDEM 2.0. As it is contained in a separate pdf document, the user can keep 
the manual open and toggle between it and the model as they follow instructions. 

The MoDEM Manual can be accessed in one of three ways: 

1. Opening the pdf file directly, using Acrobat Reader. 

2. Clicking on Help → Index of Help Topics in the MoDEM Menu Bar. This 
brings up an index of topics from which the user can select the desired help 
topic. Clicking on a topic opens the MoDEM Manual at the section relevant to 
that topic. 

3. Clicking on the black ‘Instructions’ button at the top of most screens visible in 
Interface Mode. This opens the MoDEM Manual at the help topic relevant to the 
current screen. 

Please ensure that the MoDEM Manual is stored in the same directory as the 
MoDEM 2.0 file, and that the manual file is named manual.pdf. This ensures that 
the manual can be successfully accessed by methods 2 and 3 above. 
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3 Detailed Projection module 

The Detailed Projection module consists of 16 separate screens that guide the user 
through the selection of demographic and economic parameters. This module is 
used to enter all of the assumptions to create a scenario, compare two scenarios, and 
save a scenario to later test the effect of labour supply shocks (using the Labour 
Supply Shocks module, discussed in chapter 8).  

The user can choose to set all parameters to the default (‘Medium’) settings, in 
order to limit the amount of user input required (or to restore the default scenario 
after creating a user scenario). A description of the assumptions underpinning the 
default (‘Medium’) scenario is given in Appendix C. 

The steps required for each input screen in the detailed projection are listed below. 
On each screen, users are able to: 

• Click on the ‘INSTRUCTIONS’ button to access the MoDEM Manual and view 
instructions for that step of the Detailed Projection module.  

• Select preset parameter values, imported parameter values (imported through 
MoDEM Export/Import module, see chapter 6) or input user data in the grey 
cells.  

• Validate selected parameters to ensure that they are sensible assumptions. 

The last of these features — the MoDEM Validate tool — is discussed below. Also 
discussed below is a feature accessible from steps 1, 5 and 16 of the Detailed 
Projection module, the Scenario Summary screen. 

3.1 MoDEM Validate tool 

The MoDEM Validate tool allows users to check the values they have entered for a 
given parameter against some indicators of what might be ‘reasonable’ values. 
When the user clicks ‘Validate’, MoDEM compares the user input data with inbuilt 
values that might be considered ‘high’ and ‘low’ for that parameter. 

For example, suppose the user has entered labour force participation rates. MoDEM 
checks these participation rates against preset ‘high’ and ‘low’ boundaries for each 
age-sex group. For males aged 60 to 64, for instance, it is assumed that a 
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participation rate below 35% is probably ‘low’ and a rate above 65% is probably 
‘high’. So, if the user has entered a rate of 80% for this age group, the Validate tool 
will indicate that this value is unusually ‘high’. 

It is important to note that this judgment is based purely on ‘eyeballing’ the last few 
decades of data for each variable, and does not need to be taken as definitive. The 
Validate tool is intended only to indicate where user input values might be outside 
‘reasonable’ boundaries. It does not force the user to revise the values, as the 
scenario might have been deliberately intended to calculate projections for an 
extreme case! Rather, the tool is designed to be an extra check on the data to pick 
up where an error might have been made that would dramatically affect projection 
results. 

3.2 Scenario Summary screen 

The Scenario Summary screen shows all active settings for the current scenario, 
including demographic and labour parameters as well as labour supply shocks. This 
screen is designed to provide an ‘at a glance’ summary of the active scenario. For 
more detailed information on the settings for each parameter, users should view the 
step-by-step screens in the Detailed Projection module. 

From the Scenario Summary screen, users are able to modify any of the settings by 
clicking on the ‘Modify’ button next to the selected group of parameters. Users can 
also re-active the imported scenario (that is, make the imported scenario the active 
scenario — see also chapter 6 on the Export/Import module), restore the default 
(‘Medium’) scenario settings, save the current scenario, or view projection results. 

3.3 Graphs in the Detailed Projection module 

Each screen in the Detailed Projection module contains one or more graphs 
illustrating the settings for a given parameter(s). Changing the selection in the 
pull-down menus will change the values used for the graphs. However, some graphs 
will refresh automatically to incorporate these changes, and others need to be 
manually refreshed using the ‘Refresh’ button located next to the graph. 

The following is a list of the graphs that must be manually refreshed after changing 
parameter settings: 

• Civilian Population Ratios graph (in step 1 of the Detailed Projection module) 

• Fertility Pattern and Fertility Level graphs (in step 2) 
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• Emigration and Immigration Age Pattern graphs (in step 3) 

• Migration Level graph (in step 4) 

• The upper graph in each of the labour supply parameters (steps 6 to 15) 

• Relative Productivity graph (in step 16) 

3.4 Instructions for using the Detailed Projection 
module 

This section gives step-by-step instructions to creating a scenario using the Detailed 
Projection module in MoDEM 2.0.  

To begin the process, the user should click ‘Launch’ next to the Detailed Projection 
item on the MoDEM Main Menu screen, or select Detailed Projection → Base 
Population from the MoDEM Menu Bar. 

The left and right arrows at the top of each screen can be used to navigate through 
the module. Alternatively, users can ‘jump’ directly to the desired screen using the 
Menu Bar.  

Note that if columns are too narrow to view user data properly, they can be widened 
in Expert Mode (see chapter 9). This applies to all worksheets visible in Interface 
Mode. 

1. Enter Expert Mode by choosing Expert User → Expert Mode from the MoDEM 
Menu Bar. 

2. Select Tools → Protection → Unprotect Sheet from the Excel menu bar. This 
allows the user to modify the worksheet, including adjusting column widths. 
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Step 1 — Base Population 

1. Civilian Population Ratios:  

(a) Choose the male (M) and female (F) scenarios from the pull-down menus. 
The civilian population ratios are defined as civilian population divided by 
total population, where total population comprises the civilian population 
and defence personnel.1 MoDEM uses these base year ratios throughout the 
projection period to convert projections of total population into civilian 
population. 

(b) To enter user data, enter the desired values in the grey cells, set the 
pull-down menus to ‘User’ and click the ‘Validate’ button to ensure your 
scenario is sensible. 

2. Ensure that your desired scenario is shown in the outlined box next to each 
pull-down menu. These boxes show the scenarios that are active in MoDEM. 

3. Base Year: If you would like to use a different (later) base year from that shown 
in the outlined box, click on the ‘MoDEM Update’ button. This will take you to 
the Update menu, from which you can change the base year and enter new 
estimated resident population data. 

4. Base Scenario: To set all parameters to the MoDEM default (‘Medium’) settings, 
thus creating the MoDEM default (‘Medium’) scenario, click the ‘MoDEM 
Medium’ button. This allows the user to quickly create a scenario with minimal 
input, or to restore the original settings after trying different parameter values. 

5. Graphs: View your assumptions about the civilian population ratio and estimated 
resident population in the graphs. If you have changed the civilian population 
ratios, click the ‘Refresh’ button to update the civilian population ratio graph. 
(The Estimated resident population (ERP) chart on the right updates 
automatically.) 

6. Scenario Summary: To view all active settings in the current scenario, click on 
the ‘Scenario Summary’ button. 

7. At the top of the screen, click the forward arrow to go to the next screen, or the 
back arrow to return to the main menu. 

 
1 These ratios should normally be close to, but less than or equal to, one. However, in the base 

scenario there are several ratios greater than one. This is the result of the data for total population 
(derived from the census) being based at June 30, whereas civilian population (derived from the 
Labour Force Survey for consistency with the labour parameters) is based at Dec 31. In 
calculating the civilian population ratios for the base year, MoDEM uses a two year moving 
average of total population to put it in the same timeframe as civilian population. 
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Step 2 — Fertility Pattern and Level 

1. Fertility Age Pattern:  

(a) For the base year, choose an age pattern scenario for fertility from the 
pull-down menu. The yellow cells show the age pattern for the active 
scenario as shares. The white cells represent the pattern as (indicative) 
levels. (The base year for the fertility pattern assumption is the same as the 
MoDEM base year.)  

(b) To enter user data, enter the desired values in the grey cells, set the 
pull-down menus to ‘User’ and click the ‘Validate’ button to ensure your 
scenario is sensible. 

2. Intermediate Year: 

(a) Click the ‘Intermediate Year’ button to specify an intermediate year for the 
age pattern scenario for fertility. The intermediate year must be within the 
projection period. MoDEM will linearly interpolate between the patterns for 
the base and intermediate years. The intermediate pattern is used for all 
subsequent years. 

(b) For the intermediate year, choose a fertility pattern scenario from the 
pull-down menu. The yellow cells show the age pattern for the active 
scenario as shares. The white cells represent the pattern as (indicative) 
levels. To enter user data, enter the desired values in the grey cells, set the 
pull-down menus to ‘User’ and click the ‘Validate’ button to ensure your 
scenario is sensible. 

3. Ensure that your desired scenario is shown in the outlined box next to each 
pull-down menu. These boxes show the assumptions that are active in MoDEM. 

4. Fertility Level:  

(a) Choose the scenario for the fertility level (Total Fertility Rate, or TFR) from 
the pull-down menu. To enter user data, enter the desired values in the grey 
cells and then set the pull-down menu to ‘User’. If user data are entered, 
click the ‘Validate’ button to ensure that your assumptions are reasonable.  

(b) Ensure your scenario is shown in the outlined box below the pull-down 
menu. This box shows the assumptions that are active in MoDEM. 

5. Graphs: View your assumptions about fertility in the graphs. If you have 
changed the years, fertility patterns or levels in the previous steps, click the 
‘refresh’ buttons to update each graph. The comparison pull-down menu below 
each graph allows the user to view alternative scenarios against the active 
scenario. After selecting a comparison scenario, click the ‘refresh’ button to 
update the graph. 
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6. At the top of the screen, click the forward arrow to go to the next screen, or the 
back arrow to return to the Base Population screen. 
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Step 3 — Migration: Age Pattern 

1. Emigration Age Pattern:  

(a) Choose the male (M) and female (F) emigration pattern scenarios from the 
pull-down menus. 

(b) To enter user data, enter the desired values in the grey cells, set the 
pull-down menus to ‘User’ and click the ‘Validate’ button to ensure your 
scenario is sensible. 

2. Ensure that your desired scenario is shown in the outlined box next to each 
pull-down menu. These boxes show the scenarios that are active in MoDEM. 

3. Immigration Age Pattern: 

(a) Choose the male (M) and female (F) immigration pattern scenarios from the 
pull-down menus. 

(b) To enter user data, enter the desired values in the grey cells, set the 
pull-down menus to ‘User’ and click the ‘Validate’ button to ensure your 
scenario is sensible. 

4. Ensure that your desired scenario is shown in the outlined box next to each 
pull-down menu. These boxes show the scenarios that are active in MoDEM. 

5. Graphs: View your assumptions about migration in the two graphs. The 
comparison pull-down menus below each graph allow the user to select two 
scenarios to view. The first scenario is plotted in green, the second is in red. 
After selecting the scenarios to compare, click the ‘Refresh’ button to update 
each graph. 

6. At the top of the screen, click the forward arrow to go to the next screen, or the 
back arrow to return to the Fertility screen. 
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Step 4 — Net Migration: Level 

3. Emigration:  

(a) Select the desired Emigration level scenario from the pull-down menu. 

(b) To enter user data, enter the desired values in the grey cells, set the 
pull-down menus to ‘User’ and click the ‘Validate’ button to ensure your 
scenario is sensible. 

4. Ensure that your desired scenario is shown in the outlined box next to the pull 
down menu. This box shows the scenario that is active in MoDEM. 

5. Immigration:  

(a) Select the desired Immigration level scenario from the pull-down menu. 

(b) To enter user data, enter the desired values in the grey cells, set the 
pull-down menus to ‘User’ and click the ‘Validate’ button to ensure your 
scenario is sensible. 

6. Ensure that your desired scenario is shown in the outlined box next to the pull 
down menu. This box shows the scenario that is active in MoDEM. 

7. Net Migration: Check net migration levels implied by the chosen immigration 
and emigration scenarios. In MoDEM 2.0, Net Migration is automatically 
calculated from immigration and emigration and cannot be changed directly. 

8. Graph: View the current assumptions about net migration and its components in 
the graph. The Emigration and Immigration Comparison pull-down menus 
below the graph allow the user to select additional migration scenarios to view. 
After selecting the scenarios to compare, click the ‘Refresh’ button to update the 
graph. 

9. At the top of the screen, click the forward arrow to go to the next screen, or the 
back arrow to return to the Migration Age Pattern screen. 
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Step 5 — Survival: Pattern and Trend 

1. Male Age Pattern:  

(a) Choose a scenario for the age pattern of survival for males from the pull 
down menu. There are several survival patterns to choose from for males 
and females. These patterns are the same as those in PC (2005), but with a 
base year of 2007. Further details of these series and comparisons of life 
expectancy under each scenario are given in section 2.3 of PC (2005) and 
table 1.1 of Technical Paper 1 from PC (2005). 

(b) User data for the survival pattern is not directly available as an option here. 
However, user data could be entered through the MoDEM update process 
and stored to one of the empty scenarios. That scenario could then be 
selected and used here.  

2. Ensure that your desired scenario is shown in the outlined box next to the pull 
down menu. This box shows the scenario that is active in MoDEM. 

3. Female Age Pattern:  

(c) Choose a scenario for the age pattern of survival for females from the pull 
down menu.  

(d) User data for the survival pattern is not directly available as an option here. 
However, user data could be entered through the MoDEM update process 
and stored to one of the empty scenarios. That scenario could then be 
selected and used here.  

4. Ensure that your desired scenario is shown in the outlined box next to the pull 
down menu. This box shows the scenario that is active in MoDEM. 

5. Life expectancy: 

(a) Select the desired life expectancy scenario using the M (Male) and F 
(Female) pull down menus.2 Ensure your scenarios are shown in the 
outlined boxes next to the pull down menus. These boxes show the scenarios 
that are active in MoDEM. Numbers in the first column of the table show, 
for the current scenario, the life expectancy for males and females in the 
46th year of the projection period (the year displayed in the black cell).  

(b) To enter user defined life expectancy for males and females, select ‘User’ 
from the pull down menus and enter the desired life expectancy in the grey 
cells below the USER label in the second column of the table. Click the 

 
2 The preset high, medium and low life expectancy scenarios are designed to match the various age 

pattern scenarios for mortality indicated as high, medium or low. However, users can mix these 
options as desired — MoDEM will then adjust the age specific mortality rates to achieve the 
selected life expectancy while preserving the shape of the mortality curve. 
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‘Set User’ button and wait for MoDEM as it adjusts mortality rates to 
achieve the desired life expectancy while preserving the shape of the 
mortality curve across the age groups. 

6. Graphs: View your assumptions about age patterns in mortality for males and 
females in the graphs. To see how the patterns change over the projection period, 
users can select three years to compare in each graph. Use the pull-down menus 
below each graph to select the years to display. After selecting the years to 
compare, use the ‘Zoom Out’ button to view the full scale for mortality rates 
across all age groups. To identify any projected differences between the years 
for males and females aged under 50, the ‘Zoom In’ button allows users to 
magnify the lower region of the mortality rate axis. 

7. Labour Supply Shocks Exit: If you have already specified labour supply 
scenarios and shocks and have just completed changes to demographic 
parameters as part of your shock scenario (see chapter 8), click the ‘Back to 
Shock’ button to return to the labour supply shocks module. Your new 
assumptions about civilian population ratios, fertility, migration and mortality 
have been updated in MoDEM. If you have not specified any labour supply 
scenarios, click the forward arrow at the top of the screen to go to the next 
screen, or the back arrow to return to the Net Migration Level screen. 

8. Scenario Summary: To view all active settings in the current scenario, click on 
the ‘Scenario Summary’ button. 
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Step 6 — Labour Force Participation: Males 

1. Male scenario:  

(a) Choose a scenario for male participation from the pull-down menu. Note: 
the ‘PC (2005)’ scenario for male participation rates uses parameters from 
PC (2005) (also used in the MoDEM 1.0 baseline). The ‘PC (2008)’ 
scenario uses a new set of parameter values, re-estimated using data up to 
2007 and the same methodology as the ‘PC (2005)’ scenario. The ‘Constant 
2007’ scenario uses parameters set at 2007 levels for all years of the 
projection.  

(b) To enter user data, enter the desired values in the grey cells for the six years 
shown, set the pull down menu to ‘User’ and click the ‘Validate’ button to 
ensure your scenario is sensible. The user scenario only requires data for six 
years during the projection period. MoDEM uses linear interpolation to 
calculate participation rates for the intervening years. If you prefer to 
specify participation rates for all years, use the MoDEM Update module to 
input the data and store as a new scenario that can then be accessed from the 
pull-down menu on this screen.  

2. Ensure that your desired scenario is shown in the outlined box next to the 
pull-down menu. This box shows the scenario that is active in MoDEM. 

3. Graphs: View your assumptions about male labour force participation in the two 
graphs.  

(a) Use the first graph to compare age groups and see how participation rates in 
the current scenario change between three selected years during the 
projection period. Users can select different years using the pull-down 
menus next to the graph. Click the ‘Refresh’ button to update this graph. 

(b) Use the second graph to compare changes over time between two scenarios 
for a particular age group. Users can select the age group and scenarios to 
display using the pull-down menus next to the graph. This graph updates 
automatically. 

4. At the top of the screen, click the forward arrow to go to the next screen, or the 
back arrow to return to the Survival screen. 
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Step 7 — Labour Force Participation: Females 

1. Female scenario:  

(a) Choose a scenario for female participation from the pull-down menu. Note: 
the ‘PC (2005)’ scenario for female participation rates uses parameters from 
PC (2005) (also used in the MoDEM 1.0 baseline). The ‘PC (2008)’ 
scenario uses a new set of parameter values, re-estimated using data up to 
2007 and the same methodology as the ‘PC (2005)’ scenario. The ‘Constant 
2007’ scenario uses parameters set at 2007 levels for all years of the 
projection.  

(b) To enter user data, enter the desired values in the grey cells for the six years 
shown, set the pull down menu to ‘User’ and click the ‘Validate’ button to 
ensure your scenario is sensible. The user scenario only requires data for six 
years during the projection period. MoDEM uses linear interpolation to 
calculate participation rates for the intervening years. If you prefer to 
specify participation rates for all years, use the MoDEM Update module to 
input the data and store as a new scenario that can then be accessed from the 
pull-down menu on this screen. 

2. Ensure that your desired scenario is shown in the outlined box next to the 
pull-down menu. This box shows the scenario that is active in MoDEM. 

3. Converge: MoDEM includes an option to force projected participation rates for 
females in the three oldest age groups to converge to those for males in those age 
groups. To specify the number of years by which this convergence occurs, click 
on the ‘SET’ button and a sex convergence box will appear. Use the up and 
down arrows in the box to select the assumed number of years until 
convergence. The convergence time must be within the projection period. To 
disable the convergence option (implying female participation rates are not 
forced to converge to those of males), select ‘0’ in the convergence box.  

4. Graphs: View your assumptions about female labour force participation in the 
two graphs.  

(a) Use the first graph to compare age groups and see how participation rates in 
the current scenario change between three selected years during the 
projection period. Users can select different years using the pull-down 
menus next to the graph. Click the ‘Refresh’ button to update this graph. 

(a) Use the second graph to compare changes over time between two scenarios 
for a particular age group. Users can select the age group and scenarios to 
display using the pull-down menus next to the graph. This graph updates 
automatically. 
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5. At the top of the screen, click the forward arrow to go to the next screen, or the 
back arrow to return to the Male Labour Force Participation screen. 



   

22 MODEM 2.0  

 

Step 8 — Unemployment: Males 

1. Male scenario:  

(a) Choose a scenario for male unemployment from the pull-down menu. Note: 
the ‘PC (2005)’ scenario for male unemployment rates uses parameters from 
PC (2005) (also used in the MoDEM 1.0 baseline). The ‘PC (2008)’ 
scenario uses a new set of parameter values, re-estimated using data up to 
2007 and the same methodology as the ‘PC (2005)’ scenario. The ‘Constant 
2007’ scenario uses parameters set at 2007 levels for all years of the 
projection. 

(b) To enter user data, enter the desired values in the grey cells for the six years 
shown, set the pull down menu to ‘User’ and click the ‘Validate’ button to 
ensure your scenario is sensible. The user scenario only requires data for six 
years during the projection period. MoDEM uses linear interpolation to 
calculate unemployment rates for the intervening years. If you prefer to 
specify unemployment rates for all years, use the MoDEM Update module 
to input the data and store as a new scenario that can then be accessed from 
the pull-down menu on this screen.  

2. Ensure that your desired scenario is shown in the outlined box next to the 
pull-down menu. This box shows the scenario that is active in MoDEM. 

3. Graphs: View your assumptions about male unemployment in the two graphs.  

(a) Use the first graph to compare age groups and see how unemployment rates 
in the current scenario change between three selected years during the 
projection period. Users can select different years using the pull-down 
menus next to the graph. Click the ‘Refresh’ button to update this graph. 

(b) Use the second graph to compare changes over time between two scenarios 
for a particular age group. Users can select the age group and scenarios to 
display using the pull-down menus next to the graph. This graph updates 
automatically. 

4. At the top of the screen, click the forward arrow to go to the next screen, or the 
back arrow to return to the Female Labour Force Participation screen. 
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Step 9 — Unemployment: Females 

1. Female scenario:  

(a) Choose a scenario for female unemployment from the pull-down menu. 
Note: the ‘PC (2005)’ scenario for female unemployment rates uses 
parameters from PC (2005) (also used in the MoDEM 1.0 baseline). The 
‘PC (2008)’ scenario uses a new set of parameter values, re-estimated using 
data up to 2007 and the same methodology as the ‘PC (2005)’ scenario. The 
‘Constant 2007’ scenario uses parameters set at 2007 levels for all years of 
the projection. 

(b) To enter user data, enter the desired values in the grey cells for the six years 
shown, set the pull down menu to ‘User’ and click the ‘Validate’ button to 
ensure your scenario is sensible. The user scenario only requires data for six 
years during the projection period. MoDEM uses linear interpolation to 
calculate unemployment rates for the intervening years. If you prefer to 
specify unemployment rates for all years, use the MoDEM Update module 
to input the data and store as a new scenario that can then be accessed from 
the pull down menu on this screen.  

2. Ensure that your desired scenario is shown in the outlined box next to the 
pull-down menu. This box shows the scenario that is active in MoDEM. 

3. Graphs: View your assumptions about female unemployment in the two graphs.  

(a) Use the first graph to compare age groups and see how unemployment rates 
in the current scenario change between three selected years during the 
projection period. Users can select different years using the pull down 
menus next to the graph. Click the ‘Refresh’ button to update this graph. 

(b) Use the second graph to compare changes over time between two scenarios 
for a particular age group. Users can select the age group and scenarios to 
display using the pull down menus next to the graph. This graph updates 
automatically. 

4. At the top of the screen, click the forward arrow to go to the next screen, or the 
back arrow to return to the Male Unemployment screen. 
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Step 10 — Part-Time Work Share: Males 

1. Male scenario:  

(a) Choose a scenario for the split between part-time and full-time work for 
males from the pull down menu. Note: the ‘PC (2005)’ scenario for the 
part-time work share for males uses parameters from PC (2005) (also used 
in the MoDEM 1.0 baseline). The ‘PC (2008)’ scenario uses a new set of 
parameter values, re-estimated using data up to 2007 and the same 
methodology as the ‘PC (2005)’ scenario. The ‘Constant 2007’ scenario 
uses parameters set at 2007 levels for all years of the projection. 

(b) To enter user data, enter the desired values in the grey cells for the six years 
shown, set the pull-down menu to ‘User’ and click the ‘Validate’ button to 
ensure your scenario is sensible. The user scenario only requires data for six 
years during the projection period. MoDEM uses linear interpolation to 
calculate part-time work shares for the intervening years. If you prefer to 
specify part-time work shares for all years, use the MoDEM Update module 
to input the data and store as a new scenario that can then be accessed from 
the pull-down menu on this screen.  

2. Ensure that your desired scenario is shown in the outlined box next to the 
pull-down menu. This box shows the scenario that is active in MoDEM. 

3. Graphs: View your assumptions about the split between part-time and full-time 
work for males in the two graphs.  

(a) Use the first graph to compare age groups and see how part-time work 
shares in the current scenario change between three selected years during the 
projection period. Users can select different years using the pull-down 
menus next to the graph. Click the ‘Refresh’ button to update this graph. 

(b) Use the second graph to compare changes over time between two scenarios 
for a particular age group. Users can select the age group and scenarios to 
display using the pull-down menus next to the graph. This graph updates 
automatically. 

4. At the top of the screen, click the forward arrow to go to the next screen, or the 
back arrow to return to the Female Unemployment screen. 
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Step 11 — Part-Time Work Share: Females 

1. Female scenario:  

(a) Choose a scenario for the split between part-time and full-time work for 
females from the pull-down menu. Note: the ‘PC (2005)’ scenario for the 
part-time work share for females uses parameters from PC (2005) (also used 
in the MoDEM 1.0 baseline). The ‘PC (2008)’ scenario uses a new set of 
parameter values, re-estimated using data up to 2007 and the same 
methodology as the ‘PC (2005)’ scenario. The ‘Constant 2007’ scenario 
uses parameters set at 2007 levels for all years of the projection. 

(b) To enter user data, enter the desired values in the grey cells for the six years 
shown, set the pull down menu to ‘User’ and click the ‘Validate’ button to 
ensure your scenario is sensible. The user scenario only requires data for six 
years during the projection period. MoDEM uses linear interpolation to 
calculate part-time work shares for the intervening years. If you prefer to 
specify part-time work shares for all years, use the MoDEM Update module 
to input the data and store as a new scenario that can then be accessed from 
the pull-down menu on this screen.  

2. Ensure that your desired scenario is shown in the outlined box next to the 
pull-down menu. This box shows the scenario that is active in MoDEM. 

3. Graphs: View your assumptions about the split between part-time and full-time 
work for females in the two graphs.  

(a) Use the first graph to compare age groups and see how part-time work 
shares in the current scenario change between three selected years during the 
projection period. Users can select different years using the pull-down 
menus next to the graph. Click the ‘Refresh’ button to update this graph. 

(b) Use the second graph to compare changes over time between two scenarios 
for a particular age group. Users can select the age group and scenarios to 
display using the pull down menus next to the graph. This graph updates 
automatically. 

4. At the top of the screen, click the forward arrow to go to the next screen, or the 
back arrow to return to the Male Part-Time Work Share screen. 
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Step 12 — Full-Time Average Hours: Males 

1. Male scenario:  

(a) Choose a scenario for average full-time hours worked by males from the 
pull down menu. Note: the ‘PC (2005)’ scenario for average full-time hours 
worked by males uses parameters from PC (2005) (also used in the MoDEM 
1.0 baseline). The ‘PC (2008)’ scenario uses a new set of parameter values, 
re-estimated using data up to 2007 and the same methodology as the ‘PC 
(2005)’ scenario. The ‘Constant 2007’ scenario uses parameters set at 2007 
levels for all years of the projection. 

(b) To enter user data, enter the desired values in the grey cells for the six years 
shown, set the pull down menu to ‘User’ and click the ‘Validate’ button to 
ensure your scenario is sensible. The user scenario only requires data for six 
years during the projection period. MoDEM uses linear interpolation to 
calculate average full-time hours worked for the intervening years. If you 
prefer to specify average full-time hours worked for all years, use the 
MoDEM Update module to input the data and store as a new scenario that 
can then be accessed from the pull down menu on this screen.  

2. Ensure that your desired scenario is shown in the outlined box next to the 
pull-down menu. This box shows the scenario that is active in MoDEM. 

3. Graphs: View your assumptions about average full-time hours worked by males 
in the two graphs.  

(a) Use the first graph to compare age groups and see how average full-time 
hours worked in the current scenario change between three selected years 
during the projection period. Users can select different years using the pull 
down menus next to the graph. Click the ‘Refresh’ button to update this 
graph. 

(b) Use the second graph to compare changes over time between two scenarios 
for a particular age group. Users can select the age group and scenarios to 
display using the pull-down menus next to the graph. This graph updates 
automatically. 

4. At the top of the screen, click the forward arrow to go to the next screen, or the 
back arrow to return to the Female Part-Time Work Share screen. 
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Step 13 — Full-Time Average Hours: Females 

1. Female scenario:  

(a) Choose a scenario for average full-time hours worked by females from the 
pull-down menu. Note: the ‘PC (2005)’ scenario for average full-time hours 
worked by females uses parameters from PC (2005) (also used in the 
MoDEM 1.0 baseline). The ‘PC (2008)’ scenario uses a new set of 
parameter values, re-estimated using data up to 2007 and the same 
methodology as the ‘PC (2005)’ scenario. The ‘Constant 2007’ scenario 
uses parameters set at 2007 levels for all years of the projection. 

(b) To enter user data, enter the desired values in the grey cells for the six years 
shown, set the pull down menu to ‘User’ and click the ‘Validate’ button to 
ensure your scenario is sensible. The user scenario only requires data for six 
years during the projection period. MoDEM uses linear interpolation to 
calculate average full-time hours worked for the intervening years. If you 
prefer to specify average full-time hours worked for all years, use the 
MoDEM Update module to input the data and store as a new scenario that 
can then be accessed from the pull-down menu on this screen.  

2. Ensure that your desired scenario is shown in the outlined box next to the 
pull-down menu. This box shows the scenario that is active in MoDEM. 

3. Graphs: View your assumptions about average full-time hours worked by 
females in the two graphs.  

(a) Use the first graph to compare age groups and see how average full-time 
hours worked in the current scenario change between three selected years 
during the projection period. Users can select different years using the pull 
down menus next to the graph. Click the ‘Refresh’ button to update this 
graph. 

(b) Use the second graph to compare changes over time between two scenarios 
for a particular age group. Users can select the age group and scenarios to 
display using the pull-down menus next to the graph. This graph updates 
automatically. 

4. At the top of the screen, click the forward arrow to go to the next screen, or the 
back arrow to return to the Male Full-Time Hours screen. 
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Step 14 — Part-Time Average Hours: Males 

1. Male scenario:  

(a) Choose a scenario for average part-time hours worked by males from the 
pull down menu. Note: the ‘PC (2005)’ scenario for average part-time hours 
worked by males uses parameters from PC (2005) (also used in the MoDEM 
1.0 baseline). The ‘PC (2008)’ scenario uses a new set of parameter values, 
re-estimated using data up to 2007 and the same methodology as the ‘PC 
(2005)’ scenario. The ‘Constant 2007’ scenario uses parameters set at 2007 
levels for all years of the projection. 

(b) To enter user data, enter the desired values in the grey cells for the six years 
shown, set the pull-down menu to ‘User’ and click the ‘Validate’ button to 
ensure your scenario is sensible. The user scenario only requires data for six 
years during the projection period. MoDEM uses linear interpolation to 
calculate average part-time hours worked for the intervening years. If you 
prefer to specify average part-time hours worked for all years, use the 
MoDEM Update module to input the data and store as a new scenario that 
can then be accessed from the pull-down menu on this screen.  

2. Ensure that your desired scenario is shown in the outlined box next to the pull 
down menu. This box shows the scenario that is active in MoDEM. 

3. Graphs: View your assumptions about average part-time hours worked by males 
in the two graphs.  

(a) Use the first graph to compare age groups and see how average part-time 
hours worked in the current scenario change between three selected years 
during the projection period. Users can select different years using the 
pull-down menus next to the graph. Click the ‘Refresh’ button to update this 
graph. 

(b) Use the second graph to compare changes over time between two scenarios 
for a particular age group. Users can select the age group and scenarios to 
display using the pull-down menus next to the graph. This graph updates 
automatically. 

4. At the top of the screen, click the forward arrow to go to the next screen, or the 
back arrow to return to the Female Full-Time Hours screen. 

 



   

 DETAILED 
PROJECTION MODULE

29

 

Step 15 — Part-Time Average Hours: Females 

1. Female scenario: 

(a) Choose a scenario for average part-time hours worked by females from the 
pull down menu. Note: the ‘PC (2005)’ scenario for average part-time hours 
worked by females uses parameters from PC (2005) (also used in the 
MoDEM 1.0 baseline). The ‘PC (2008)’ scenario uses a new set of 
parameter values, re-estimated using data up to 2007 and the same 
methodology as the ‘PC (2005)’ scenario. The ‘Constant 2007’ scenario 
uses parameters set at 2007 levels for all years of the projection. 

(b) To enter user data, enter the desired values in the grey cells for the six years 
shown, set the pull down menu to ‘User’ and click the ‘Validate’ button to 
ensure your scenario is sensible. The user scenario only requires data for six 
years during the projection period. MoDEM uses linear interpolation to 
calculate average part-time hours worked for the intervening years. If you 
prefer to specify average part-time hours worked for all years, use the 
MoDEM Update module to input the data and store as a new scenario that 
can then be accessed from the pull-down menu on this screen.  

2. Ensure that your desired scenario is shown in the outlined box next to the 
pull-down menu. This box shows the scenario that is active in MoDEM. 

3. Graphs: View your assumptions about average part-time hours worked by 
females in the two graphs.  

(a) Use the first graph to compare age groups and see how average part-time 
hours worked in the current scenario change between three selected years 
during the projection period. Users can select different years using the pull 
down menus next to the graph. Click the ‘Refresh’ button to update the first 
graph. 

(b) Use the second graph to compare changes over time between two scenarios 
for a particular age group. Users can select the age group and scenarios to 
display using the pull-down menus next to the graph. This graph updates 
automatically. 

4. At the top of the screen, click the forward arrow to go to the next screen, or the 
back arrow to return to the Male Part-Time Hours screen. 

 



   

30 MODEM 2.0  

 

Step 16 — Productivity Options 

1. Relative Productivity:  

(a) Choose the male (M) and female (F) relative productivity scenario from the 
pull-down menus. These scenarios determine whether and by how much 
productivity varies between age groups.  

(b) To enter user data, enter the desired values in the grey cells, set the pull 
down menus to ‘User’ and click the ‘Validate’ button to ensure your 
scenario is sensible.  

2. Ensure that your desired scenario is shown in the outlined box next to each pull 
down menu. These boxes show the scenarios that are active in MoDEM. 

3. Graph: Click the ‘Refresh’ button to update the graph and view your 
assumptions about relative productivity for each age group.  

4. Aggregate Productivity Rate:  

(a) Choose the aggregate productivity rate scenario from the pull down menu.  

(b) To enter user data, enter the desired rate in the grey cell and set the pull 
down menu to ‘User’. Ensure that your desired scenario is shown in the 
outlined box next to the pull down menu.  

(c) The rate next to the scenario is assumed to apply in the same way each year. 
If the relative productivity scenario allows age-varying productivity, the rate 
implied by relative productivity in the outlined box may differ slightly from 
the assumed rate if the age profile for hours worked changes.  

5. View Scenario Summary: Click the ‘Scenario summary’ button to view a 
summary of the active settings for this scenario. 

6. Set or View Results:  

(a) If you wish to compare scenarios or use the labour supply shocks module, 
click the ‘Set as Baseline’ button to save the current assumptions and results 
as the baseline scenario (and then wait while MoDEM reloads).  

(b) To navigate directly to the projection results for the scenario, click on the 
‘Results’ button. 

7. At the top of the screen, click the forward arrow (or click on the ‘Results’ 
button) to go to the next screen, or the back arrow to return to the Female 
Part-Time Hours screen. 
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4 Results module 

The Results module allows users to examine demographic and economic 
projections from the scenarios.  

Projection results are presented in two groups, demographic results and economic 
results. For each group, users can access 

• a Summary Table of key parameters and their values at an aggregate level over 
the projection period 

• Static Graphs of all parameters in the summary table 

• Animated Graphs showing how selected parameters, split by age, sex and 
projection year, evolve over the projection period 

• Detailed tables of selected parameters 

For the demographic parameters, there are detailed results tables by age, sex and 
projection year for the following: 

1. Resident Population 

2. Civilian Population 

3. Emigrants 

4. Immigrants 

5. Deaths 

6. Survivors 

7. Births 

For the economic parameters, there are detailed tables of results by age, sex and 
projection year for the following: 

1. Total Labour Inputs 

2. Efficiency Units of Labour 

3. Workers 

4. Labour Force 
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Users can also navigate directly to the static and animated graphs from the detailed 
results tables. 

4.1 Using the results screens 

To access the Results module, the user should click on the ‘Launch’ button next to 
the Results item on the MoDEM Main Menu. Alternatively, users can select 
Menus → Results from the MoDEM Menu Bar, or navigate directly to the desired 
results screen using the Results sub-menu on the Menu Bar. 

From the Results menu, users can also view a summary of the active settings for the 
current scenario by clicking on the ‘Summary’ button, or return to the MoDEM 
Main Menu screen by selecting ‘Exit’. 

Summary tables and detailed results tables 

1. Select the desired scenario from the pull-down menu. Users can view results as a 
single scenario or as deviations between two scenarios. Single scenarios show 
results from the Detailed Projection module (baseline or current scenario), or 
from the Detailed Projection and Labour Supply Shocks modules combined 
(shock scenario). The (total) deviation scenario shows the difference between the 
shock scenario and the baseline. For economic results, users can view two extra 
deviation scenarios that split the total deviation (shock – baseline) into a ‘labour 
supply deviation’ (shock – current) scenario and a ‘demographic deviation’ 
(current – baseline) scenario. The demographic deviation scenario allows users 
to view the effects on economic variables of changing the population 
demography only (see Change Demography in chapter 8). 

2. To save results as a CSV (comma-separated value) file for further analysis, click 
the ‘Save *.csv’ button. The user will be prompted with a form to enter a 
filename and directory for the file to be saved. The CSV file can then be opened 
in any standard spreadsheet or statistical package. These CSV files may require 
the user to manually include additional information (like scenario names) outside 
MoDEM. 

3. To view a graph of the results, click ‘Graph’ for static graphs (where applicable), 
or ‘Animate’ for animated graphs (where applicable), and select the relevant 
scenario and variable. 

4. At the top of the screen, click the back arrow to return to the Results menu. 
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Static graphs 

1. Select a scenario from the pull-down menu for each graph. Users can choose 
from the baseline scenario, the current scenario and the shock scenario. 

2. Select the variable to graph from the ‘Variable’ pull-down menu. 

3. To save results as a Graphics Interchange Format (GIF) file, click the ‘Save 
Chart as *.gif’ button. The user will be prompted with a form to enter a filename 
and directory for the file to be saved. The file can then be opened in any word 
processor or graphics package. These GIF files only include the information 
displayed on the chart, and require users to manually include additional 
information (scenarios and variables) outside MoDEM. 

4. At the top of the screen, click the back arrow to return to the results menu.  

Animated graphs 

1. Select a scenario for both graphs from the ‘Scenario’ pull-down menu. Users can 
choose from the baseline scenario, the current scenario and the shock scenario. 

2. Select the variable to graph from the pull-down menu. 

3. Choose years for each graph using the up and down arrows. The current year 
will be displayed next to the ‘Year 1’ and ‘Year 2’ labels. 

4. To rescale the axis of the graph at any time, click ‘Rescale’. 

5. To save results as a GIF file, click the ‘Save Chart as *.gif’ button. The user will 
be prompted with a form to enter a filename and directory for the file to be 
saved. The file can then be opened in any word processor or graphics package. 
These GIF files only include the information displayed on the chart, and require 
users to manually include additional information (like scenarios and variables) 
outside MoDEM. 

6. At the top of the screen, click the back arrow to return to the results menu. 
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5 Using the Projection Wizard 

The Projection Wizard is designed for experienced users to quickly enter 
assumptions for parameters without viewing the underlying data. It can be thought 
of as an express alternative to the Detailed Projection module, for users who are 
familiar with MoDEM 2.0. 

The Projection Wizard consists of eight steps: 

1. Base Civilian Population Ratio 

2. Fertility Assumptions 

3. Migration Assumptions 

4. Survival Assumptions 

5. Male Labour Supply Assumptions 

6. Female Labour Supply Assumptions 

7. Productivity Assumptions 

8. Setting Results for Further Analysis 

5.1 Using the Projection Wizard 

To begin using the Projection Wizard, users should click on the ‘Launch’ button 
next to the Wizard item on the MoDEM Main Menu. Alternatively, users can select 
Expert User → Projection Wizard from the MoDEM Menu Bar. 

For each parameter, choose a scenario using the list boxes. Users can navigate 
between the steps of the wizard using the ‘Back’ and ‘Next’ buttons. 

In step 8, users can choose to navigate directly to the Results module by clicking the 
‘Next’ button. Active settings can be viewed from links to the scenario summary 
sheet on the results menu. Alternatively, users can set the active scenario as the 
baseline scenario by clicking the ‘Set Baseline’ button at this step. This allows the 
current settings to be stored as the baseline scenario, so that the user can apply 
labour supply shocks or compare the current scenario with another scenario. 
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6 Export/Import module 

The MoDEM Export/Import module enables both new and more experienced 
MoDEM users to save scenarios in a compact, tabulated format and to distribute 
these scenarios to other MoDEM users. 

To access the Export/Import module, users should click on the ‘Launch’ button next 
to the Export/Import Scenario item on the MoDEM Main Menu. Alternatively, 
users can select MoDEM Export/Import and then either Export or Import from the 
MoDEM Menu Bar to bypass the menus. 

On the Export/Import menu screen, users can choose to 

1. Export the current scenario: 

(a) Click on the ‘Launch’ button under the Export Menu heading.  

(b) Enter a name for the current scenario and enter a user name and any 
comments, if desired. 

(c) Click ‘OK’. This brings up a prompt to name the resulting *.csv 
(comma-separated value) file and save it in a chosen directory. The file is 
approximately 365 Kb unzipped, allowing users to easily email or archive it. 

2. Import a previously saved (exported) scenario:  

(a) Click on the ‘Launch’ button under the Import Menu heading. 

(b) Select the desired saved scenario (a *.csv file), and be patient while 
MoDEM imports the scenario. Depending on the speed of the computer, this 
step may take 15–30 seconds. 

(c) The Import Menu then updates to display the scenario name, date, time, 
username and comments for the scenario that was imported. 

3. View a summary of all currently active settings, by clicking ‘Launch’ next to the 
Scenario Summary item. 

4. View projection results, by clicking ‘Launch’ next to the Results item. 

5. Return to the MoDEM Main Menu screen, by selecting ‘Exit’. 
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When importing a scenario, please note: 

• Imported scenarios must have the same base year as the MoDEM base year.  

– The MoDEM base year is listed on the scenario summary sheet. 

– The MoDEM base year can be changed to a later year using the Update 
module, discussed in chapter 7. 

• Importing a scenario automatically makes it the active scenario, and it is stored 
as the ‘Imported’ scenario in pull-down menus. After changing any selections, 
the imported scenario can be fully reinstated as the active scenario by navigating 
to the Scenario Summary sheet and clicking on the ‘Launch’ button next to the 
item ‘Re-activate the imported scenario’. 

• To import a scenario with labour supply shocks (discussed in chapter 8) as well 
as a baseline scenario, two csv files are needed to ensure the correct comparison 
with, and decomposition against, the baseline scenario. 

– First, the user must import a csv file containing the appropriate baseline 
scenario. Once loaded, select ‘Set as Baseline’ from the MoDEM Menu Bar.  

– Then, the user must import a second csv file containing the labour supply 
shock scenario. This will overwrite the previous scenario settings in the 
imported scenario. Failure to complete the first import will result in 
erroneous decompositions, particularly for the deviation results. 
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7 Update module 

The Update module allows users to add their own custom scenarios to MoDEM’s 
preset scenarios, by uploading their own data into the MoDEM database. 

The module consists of eight update screens: 

1. Update Year and Database 

2. Population, Productivity and Fertility Update 

3. Migration and Survival Update 

4. Participation Update 

5. Unemployment Update 

6. Part-Time Work Share Update 

7. Full-Time Hours Update 

8. Part-Time Hours Update 

To access the Update module, users should click on the ‘Launch’ button next to the 
MoDEM Update item on the Main Menu screen. Alternatively, users can select 
Menus → MoDEM Update from the MoDEM Menu Bar for the Update menu 
screen, or navigate directly to the desired update screen using the Update sub-menu 
on the Menu Bar. 

Instructions on using the update screens are given below. 
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7.1 Update Year and Database 

This screen enables users to update the MoDEM base year by choosing a new base 
year and entering estimated resident population (ERP) data for the new base year. 
To use this screen: 

1. From the Update Menu, click ‘Update Year and Database’.  

2. Enter the new base year for the projection in the grey box labelled ‘New’. 

3. Enter the new base year ERP, measured at June 30. MoDEM requires ERP data 
for each sex by single year of age from 0 to 100+. ERP data for Australia are 
available from the Australian Bureau of Statistics website (www.abs.gov.au). 

4. Click on the ‘Validate’ button to check whether your assumptions are realistic. 

5. Enter the ERP for one year prior to the new base year (also measured at June 
30).1 MoDEM requires ERP data for each sex by single year of age from 0 to 
100+. ERP data for Australia are available from the Australian Bureau of 
Statistics website (www.abs.gov.au). 

6. Click on the ‘Validate’ button to check whether your assumptions are realistic. 

7. Click on the ‘Activate’ button to load your new ERP data into MoDEM and to 
recalibrate the databases. The initial value of real GDP (in $2006-07) will be 
updated for the new base year using a projection of real GDP from the 
corresponding year in the baseline scenario. Wait while MoDEM recalculates. 
Note: see Warning, below. 

Warning: 

Failure to complete the three key steps (entering the new base year, entering the 
new base year ERP, and entering the ERP for the year prior to the new base year) 
will result in severe errors in MoDEM.  

• At a minimum, MoDEM requires the new base year to be entered, and it must be 
within 10 years of the current base year. For example, using the 2007 base year, 
users can only move the base year as far as 2017 in one update.  

• Failure to include the correct base year ERP will result in errors throughout the 
results.  

• Failure to include the correct one year lagged ERP will result in incorrect 
estimates of the projected civilian population and labour supply. 

 
1 MoDEM uses ERP at (base year – 1) to construct a moving average of total population, from 

which civilian population (and therefore labour market) projections are generated. 
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Important note: The ‘Activate’ button is the final step in the Update Year and 
Database screen. This button should only be clicked after correctly entering the new 
base year and the appropriate sets of ERP data. A change in the MoDEM base year 
cannot be reversed except by closing MoDEM 2.0 without saving any changes. 

7.2 All other update screens 

To use any of the other update screens (besides the Update Year and Database 
screen): 

1. Enter the required data in the grey cells. 

2. Enter a label for the new scenario in the grey ‘Label’ boxes. 

3. Use pull-down menus to choose a storage space for your new assumptions, 
either by selecting an ‘Empty’ space in the database, or by overwriting previous 
user-defined scenarios. Note that the update process does not overwrite inbuilt 
MoDEM assumptions.  

4. Click ‘Validate’ to check whether your assumptions are realistic. 

5. Click ‘Update’ (or, where separate, use Male and Female buttons) to load your 
new data into MoDEM. Wait while MoDEM recalculates.  

Warning: 

Failure to complete all steps will result in severe errors in MoDEM. In particular,  

• failure to validate the data before updating may result in spurious projections 

• failure to enter a label for the scenario will result in a ‘blank’ named scenario 
which may not be visible from the detailed projection screens.  
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8 Labour supply shocks module 

The labour supply shocks module allows users to implement policy scenarios that 
shock: participation, unemployment, hours worked (including part-time share) and 
productivity.  

Demographic parameters in a scenario can also be changed, although this involves 
entering new values in the demographic screens of the Detailed Projection module 
rather than just entering incremental shocks. 

Before using the labour supply shocks module, the user must have: 

• Successfully created a scenario using the Detailed Projection module or 
Projection Wizard, or have imported a previously saved scenario using the 
Export/Import module, and  

• Saved this scenario as the baseline scenario, either by clicking ‘Set as Baseline’ 
in Step 16 of the Detailed Projection module, clicking ‘Set as Baseline’ in the 
last step of the Projection Wizard, or choosing ‘Set as Baseline’ from the 
MoDEM Menu Bar after importing a scenario using Export/Import. 

8.1 Sub Shocks 

MoDEM enables the user to implement up to three separate policy sub shocks for 
labour supply, named Sub 1 – Sub 3, in the Labour Supply Shocks module.  

1. Labour Supply Shock Menu: For each sub shock, turn the shocks for 
participation, unemployment, hours worked and productivity all on or all off 
using the ‘On/Off’ buttons. Alternatively, use the ‘Toggle’ buttons to create sets 
of shocks with some parameters turned on and others turned off. The only 
restriction on combinations of sub shocks is that hours cannot be shocked unless 
shocks to part-time work share are turned on using the ‘On/Off’ button on the 
corresponding sub shock sheet for part-time work share. 

2. To begin entering shocks, click the ‘Launch’ button next to Sub 1 to go to the 
participation (Sub 1) sheet. 

3. Sub shocks: Enter the required shocks in the grey cells for males and females 
respectively. Scroll down the screen to view cells for the last part of the 
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projection period. When entering shocks, ensure that the outlined box next to the 
‘On/Off’ button on the sub shock sheet is turned on. This button is linked to the 
corresponding ‘Toggle’ button on the Labour Supply Shock Menu and shows 
whether the shocks are active. 

4. At the top of the screen, click the forward arrow to go to the next step, or the 
back arrow to go back one step. At any stage, the user can return directly to the 
labour supply shocks menu using the MoDEM menu on the toolbar. 

5. Repeat steps 3 and 4 to enter shocks for other labour supply components: 
unemployment, part-time share, full-time hours, part-time hours and 
productivity. 

6. Repeat steps 1–5 for Sub 2 and Sub 3 if additional sub shocks are desired. 

Data types required:  

1. Sub shocks for participation, unemployment and part-time shares are in 
percentage points.  

2. Sub shocks for full-time and part-time hours are in hours.  

3. Productivity shifters are in percentage points. 

Note: Each of the three sub shocks can be turned on or off from the main Labour 
Supply Shocks Menu if desired. However, the user must enter the sub shock sheets 
to record the direction and size of the shocks. 

Consolidation Factor 

If more than one set of sub shocks is used, once the complete set of sub shocks is 
entered, return to the Labour Supply Shocks Menu and click the ‘Launch’ button 
next to Consolidation Options to choose the method and weighting factor for 
consolidating the parameters. 

1. Enter a weight for the consolidation in the text box. The number next to the text 
box shows the weight that is currently active in MoDEM. 

2. Choose your consolidation method using the list box. MoDEM supports the 
following methods: Sum, Average, Max, and Max – Min. 

3. Click ‘OK’ to load your new consolidation options, or ‘Cancel’ to continue with 
the previous options. 

4. Ensure that your choice of weight and method are shown in the outlined boxes 
on the labour supply shocks menu. 
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Outsider Discounts 

When simulating a scenario that increases labour force participation, an important 
consideration is the use of Outsider Discounts. MoDEM offers four types of 
discounts: (1) Productivity Ratio for Incremental Labour, (2) Incremental Labour 
Relative Propensity for Employment, (3) Average Hours Worked Ratio for 
Incremental Labour and (4) Incremental Labour Relative Propensity for Full-Time 
Work.  

1. Click the ‘Launch’ button next to Outsider Discounts to choose the types and 
amounts of discounts. 

2. Click the tick box in the top left-hand corner to turn on the discounts. 

3. Enter new values for each of the four discount parameters in the boxes. The 
numbers under the MoDEM heading indicate the discounts currently active. 

4. Click ‘OK’ to load new discount values in MoDEM or ‘Cancel’ to continue with 
the previous discounts. 

Validate Labour Parameters 

To validate the consolidated parameters, click the ‘Launch’ button next to Validate 
Labour parameters. The sheet displays indicators of whether each post-shock labour 
supply parameter is ‘LOW’, ‘HIGH’ or ‘OK’. As mentioned in chapter 3, the 
validation tool is only intended to be a data check, indicating parameter values that 
might be considered unusually high or low. 

Change Demography 

As part of a policy shock, users may also need to change the underlying 
demography. This is done by changing the detailed projections for the demographic 
variables. 

1. Click the ‘Launch’ button next to Change Demography to return to the detailed 
projection module. 

2. Step through and adjust the scenarios in each of the first 5 demography screens. 

3. After changing the survival scenario (STEP 5 of 16), click the ‘Back to Shock’ 
button to return to the labour supply shocks module. 
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9 Using MoDEM in Expert Mode 

MoDEM Expert Mode enables experienced MoDEM users to view and make 
changes to the underlying formulas, databases and to edit or add VBA code. Expert 
Mode also restores the full Excel Toolbar, Formula Bar, row and column headers 
and Excel worksheet tabs. Expert Mode can be accessed from the MoDEM Main 
Menu screen (by clicking ‘Launch’ next to MoDEM Expert Mode) or from the 
MoDEM Menu Bar (MoDEM → Expert User → Expert Mode). To return to 
interface mode at any time, select MoDEM → Expert User → Interface Mode on 
the MoDEM Menu Bar.  

To minimise the risk of debug errors, users should not insert or delete rows or 
columns or move cells, as VBA does not update these references. Moreover, 
changing sheet names will cause errors in the VBA code. Expert users may, 
however, edit the cell locations in the Visual Basic for Applications (VBA) 
modules.  

9.1 Some tips for expert users 
• To change the size of rows and columns in MoDEM to aid visual clarity or to fit 

large numbers:  

– First, unprotect the worksheet. In Expert Mode, select Tools → Protection → 
Unprotect Sheet from the Excel Menu Bar. 

– Then click and drag to change the width of rows or columns using the Excel 
row and column headers. 

– Protection can be restored by selecting Tools → Protection → Protect Sheet 
from the Excel Menu Bar and using the selected options for the sheet. 

• Every so often, Excel will automatically save the MoDEM workbook in case the 
file needs to be recovered. This can take up to a few minutes and so may pose an 
interruption to users. The interval between Autosaves can be lengthened, or the 
feature can be turned off completely. Please note that this will increase the risk 
of data loss in the event of Excel crashing. 

– To change how often Excel ‘Autosaves’ the MoDEM workbook: Select 
Tools → Options and choose the ‘Save’ tab. Enter the desired interval 
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between Autosaves in minutes. Or, to disable AutoSave completely, click 
‘Disable Autorecover’. 



 
 

APPENDICES 
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A MoDEM Error Testing 

The efficient and accurate operation of MoDEM is totally dependent upon the 
quality of the input data. In most cases, users should use the validate buttons to 
ensure the plausibility of the parameters entered into the model. All grey input 
boxes have also have data validation procedures to ensure the input data is of the 
correct data type. 

Apart from these pre-processing error checks, error handling procedures have been 
written in VBA for MoDEM. In the event of an error, meaningful error messages 
have been written to provide advice to users. To minimise the risk of debug errors, 
users should not change cells, rows or sheet names, as VBA does not update these 
references. Expert users can make changes to the VBA code using the Visual Basic 
Editor accessed from Tools → Macro → Visual Basic Editor, or by pressing 
Alt + F11. 
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B Terminology 

B.1 Demographic Terms 

Age Specific Fertility Rate (ASFR): A measure of fertility for a specific age 
group, calculated as the number of live births in each age group divided by the 
female population (in thousands) in that age group. While the TFR is a measure of 
the average number of children per woman across the population, the ASFR is 
specific to a given age group.  

ASFR Peak: This is the highest ASFR across all age groups. It is a measure of the 
age at which a female of reproductive age is most likely to give birth.  

Civilian population: the total population, excluding members of the armed forces. 

Crude Birth Rate (CBR): An average measure of the number of births in a given 
year. It is calculated by dividing the number of survived births in a year by the 
mid-year population, all multiplied by 1000. 

Crude Death Rate (CDR): An average measure of the number of deaths in a given 
year. It is calculated by dividing the number of deaths in a year by the mid-year 
population, all multiplied by 1000.  

Gross Reproduction Rate (GRR): A measure of fertility limited to the female 
population. It measures the number of daughters (female births) per woman of 
reproductive age.  

Life expectancy at birth: A measure of the average number of years of life 
remaining, at age zero. 

Life Table Dependency: This dependency measure, although similar to the 
population based dependency rates, differs in that it uses ‘years lived’ (calculated 
from lifetables) as a measure of age.  

Old Age Dependency: A crude measure of economic dependency in a population. 
It is calculated as the number of persons aged 65 and over, divided by the number of 
persons of working age (15–64). 
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Population (moving average): a measure of population at 31 December, calculated 
as a two-year moving average of total population at June 30. Used to convert 
timings of population measurements to match those for labour data (fiscal year 
averages). 

Total Dependency: A crude measure of economic dependency in a population. It is 
the old age dependency rate plus the young age dependency rate.  

Total Fertility Rate (TFR): A synthetic cohort measure of fertility. The TFR of a 
population is the average number of children women would bear during their 
lifetimes if they were to experience the exact age-specific fertility rates (ASFRs) 
that apply in a given year at each age of their reproductive lives. The TFR is the 
sum of the ASFRs at a given point in time (see also ASFR). 

Young Age Dependency: A crude measure of economic dependency in a 
population. It is calculated as the number of persons aged less than 15, divided by 
the number of persons of working age (15–64).  

B.2 Economic terms 

Aggregate productivity (assumed): an index measuring the annual growth rate of 
productivity, based on a single growth rate applied to all workers. It does not 
include the effects of age-varying productivity. 

Aggregate productivity (implied): an index representing average annual 
productivity growth across all workers, based on the aggregate productivity rate and 
age-specific relative productivity. If the uniform relative productivity option is 
selected for males and females, implied and assumed aggregate productivity will be 
the same. 

Discounted per capita GDP: the present value of projected per capita GDP, based 
on a discount rate of 5 per cent. 

Efficiency units per capita: a measure of labour supply (hours) per head of 
population, where hours are weighted by a productivity index that can vary by age.  

Gross Domestic Product (GDP): a measure of the output produced by workers. In 
MoDEM, changes in GDP result from changes in the size and composition of the 
(employed) workforce — the number of workers, average hours per worker and 
worker productivity.  

Hours dependency rate: potential working hours not worked divided by hours 
worked, where the measure of potential working hours (worked and not worked) 
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assumes all employed people could potentially work 40 hours per week. Potential 
working hours not worked is the difference between a potential 40-hour working 
week and the projected ‘average hours’ working week. 

Labour force: The number of people in the civilian population, aged 15 years and 
over, who are either employed or unemployed (available for and actively seeking 
employment). 

Labour force dependency ratio: A crude measure of economic dependency in a 
population. It is calculated as the number of persons who are not working divided 
by the number of workers.  

Labour inputs: hours worked, excluding any productivity effects. 

Labour inputs (per capita): hours worked per head of population. 

Non-workers: number of people in the civilian population (aged 15 and over) who 
are unemployed or not in the labour force. 

Participation rate (aggregate): The labour force expressed as a percentage of the 
civilian population aged 15 years and over. 

Participation rate (no ageing): An aggregate participation rate based on each  
age–sex group maintaining a constant share in the civilian population. That is, each 
year the projected participation rates for the age–sex groups are combined using 
shares from 2007. 

Productivity: an index of the relationship between an hour of time worked (input) 
and what is produced during that hour of work (output). Workers with high 
productivity produce more output in an hour than workers with low productivity. 

Workers: number of employed people (aged 15 and over). 
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C MoDEM default (‘Medium’) 
scenario 

Users can choose to reset all parameters to the default (‘Medium’) scenario in step 1 
of the Detailed Projection module or from the Scenario Summary Sheet. Users may 
wish to do this in order to: 

• create a scenario with minimal user input 

• restore MoDEM to the original ‘Medium’ settings after trying different 
parameter values. 

The following is a brief description of the ‘Medium’ settings and assumptions. Full 
details of all parameter values for this default scenario, or any active or preset 
scenario, can be found in the database sheets accessible in Expert Mode (see tables 
1.1 and 1.2 in Appendix D, which list the sheets visible in Interface and Expert 
Mode and their contents). 

C.1 Fertility 

Under the default scenario, the Total Fertility Rate (TFR) is set at a constant rate of 
1.7 from 2018 to the end of the projection period. This is consistent with the 
Australian Bureau of Statistics’ (ABS) assumption for the long-term ‘medium’ TFR 
(ABS 2006).1 The TFR is set at 1.8 in 2007 (based on actual data for 2006 (ABS 
2007a)) and linear interpolation is used to project TFR figures for the period 
between 2007 and 2018.  

The default (‘Medium’) Age-Specific Fertility Rates (ASFRs) for 2007 are taken 
from ABS data for 2006 and are consistent with a TFR of 1.8 (ABS 2007a). The 
default ASFRs for the intermediate year, 2020, are set to be equal to those for 2007 
(as described above, these are equal to actual ASFRs for 2006). That is, the default 
assumption is that the age profile of fertility will not change over the period 2007 to 
2020. Users can vary this assumption by selecting the ‘Older’ or ‘Younger’ scenario 
for 2020, or by entering user data. 

 
1 However, it is slightly lower than the long-term assumption of 1.8 used in the most recent 

population projections (ABS 2008b). 
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C.2 Migration 

Under the default scenario, there is a constant net overseas migration (NOM) of 
177,000 persons per year. This is the result of constant emigration and immigration 
levels, of 210,000 persons per year and 387,000 persons per year respectively. 
These figures are based on 2006-07 ABS migration data (ABS 2008a). 

Age patterns of emigration and immigration are based on single-year age-sex 
profiles provided by the ABS for 2006-07 (ABS 2008a). 

C.3 Survival 

Based on ABS data, the default scenario begins in 2007 with life expectancy at birth 
of 79.0 years for males and 83.8 years for females (ABS 2007b). During the 
projection period, mortality rates are assumed to gradually decline to achieve life 
expectancy at birth of 88.2 years (males) and 90.8 years (females) by 2053. These 
figures result from applying the methodology used by the ABS to generate life 
expectancy assumptions for its population projections (ABS 2006, 2008b).2

MoDEM’s default scenario uses a life table provided by the ABS to create an age 
profile for mortality for each sex (ABS 2007b). This profile, also called a survival 
pattern or mortality shape, is rescaled (marginally) to be consistent with the figures 
for life expectancy at birth for males and females given above. 

C.4 Productivity and the discount rate 

The default scenario assumes an aggregate productivity growth rate of 1.5 per cent 
per year over the projection period. It also assumes uniform relative productivity 
across age–sex groups. 

A discount rate of 5 per cent is assumed, although this is only used to calculate 
discounted per capita GDP. 

 
2 In the default scenario, the annual increase in life expectancy is initially in line with its long term 

trend and then slows. ABS deaths data from 1972 to 2006 show the average annual increase in 
life expectancy was 0.32 years for males and 0.26 years for females (ABS 2007b). By 
assumption, this trend continues until 2011 in the default scenario. Thereafter, the annual increase 
in life expectancy declines linearly to 0.06 years for males and 0.03 years for females in 2053. 
These increases for the final year are determined by the smallest annual increase observed 
between 1972 and 2006 for each sex. 
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C.5 Labour supply 

The values of the labour supply parameters (participation rates, unemployment 
rates, part-time shares and average hours worked) used in the default scenario are 
the projections labelled ‘PC (2008)’. These numbers are an update of those from the 
Commission’s report on Economic Implications of an Ageing Australia (PC 2005). 
The same method has been used to generate the two sets of projections, however the 
later set includes the effects of more recent data. 
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D MoDEM worksheets 

Table 1.1 Worksheets visible in MoDEM Interface Mode 

Worksheet(s) 
name 

Description How worksheet(s) interact with other worksheet(s) 

RootMenu MoDEM Main 
Menu 

 

Links to the following: 
• Detailed Projection (DP1 and then to DPx sheets) 
• Labour Supply Shocks (LMenu and then to Lx.x sheets) 
• Scenario Summary (shows summary of active settings) 
• Results (RMenu and then to Rx sheets) 
• MoDEM Update (UMenu and then to Ux sheets) 
• Export/import scenario (SMenu) 
• Expert Mode (shows all sheets, restores toolbars, shows row 

and column headings and sheet names) 
• Projection Wizard (interactive forms that allows users to 

quickly enter assumptions for a Detailed Projection). 
• MoDEM Close (closes MoDEM) 

Scenario 
Summary

Summary of 
active settings

Allows users to see a summary of the active settings for the 
model. Users can change settings or view more detail on each 
variable through the links to: 
• Detailed Projections (DPx sheets) 
• Labour Supply Shocks (LMenu) 
• Results (RMenu) 

Also allows users to re-activate the imported scenario, restore 
the default (‘medium’) scenario and save the current settings in 
an export file.

DP1–DP16 
(DPx sheets) 

Detailed 
Projection 
sheets 

The DPx sheets together form a 16-step process for users to 
enter the input required for a detailed projection. 

The sheets contain drop-down boxes.  
• When users select a scenario from the drop-down boxes, this 

choice is reflected in an index contained in one of the 
Database sheets (db_x sheets).  

• The Database sheets then display the active scenario at the 
top, according to which scenario has been selected. 

Some of the DPx sheets also link to the validation (Vx) sheets, 
which check the numbers against those contained in the 
Validation sheet. 

All of the DPx sheets contain graphs. The graphs in sheets DP2 
to DP15 are based on data contained in sheet DPGData, while 
graphs in sheets DP1 and DP16 use data on the same sheet. 

Umenu MoDEM Update 
Menu 

Links to modules to update the base year and other parameters, 
such as fertility, migration, participation (all the Ux sheets) 

(Continued next page) 
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Table 1.1 (continued) 

Worksheet(s) 
name 

Description How worksheet(s) interact with other worksheet(s) 

U1–U8 
(Ux sheets) 

Update sheets Sheet U1 updates the base year by allowing users to enter ERP 
data for a new base year. This data gets stored in sheet 
db_Misc. In turn, the first column of the population projection 
sheet (Pop_estimate) is set equal to the ERP figures in 
db_Misc. 

Sheets U2–U8 allow users to enter new data and store the data 
in one of the ‘Empty’ scenarios. The data are then stored in the 
Database (db_x) sheets. 

The Ux sheets link to the validation (Vx) sheets, which check 
the numbers against those in the Validation sheet. 

V1–V13 
(Vx sheets) 

Validation 
sheets 

Users access these sheets from the Detailed Projection (DPx) 
sheets or the Update (Ux) sheets. The validation sheets check 
user input against numbers in the Validation sheet. 

LMenu Menu for labour 
supply shocks 

Links to the labour supply shock modules (Lx.x sheets), 
allowing users to enter up to 3 sub-shock scenarios. 

L1.1–L1.6, 
L2.1–L2.6, 
L3.1–L3.6 
(Lx.x sheets) 

Labour supply 
shock sheets 

Each group of six sheets (Lx.1 to Lx.6) represents a six-step 
process for users to input labour supply shocks. These shocks 
comprise changes to participation, unemployment, part-time 
share, and part-time and full-time average hours for males and 
females. The three groups (L1.x, L2.x, L3.x) represent the sub-
shock scenarios (users can enter up to three such scenarios). 

RMenu MoDEM 
Results Menu 

Links to the results (Rx) sheets for Demographic and Economic 
variables. 

R1–R13 
(Rx sheets) 

Results sheets These sheets are accessed via the Results Menu (RMenu) and 
contain tables showing the projected values for Demographic 
and Economic variables. Users will generally access these 
sheets after completing a Detailed Projection, using the 
Projection Wizard, or adding labour supply shocks to an existing 
scenario. 

Some of the Rx sheets offer a graph or ‘Animate’ option, which 
links to one of the graph (Gx) sheets. The user is then able to 
select what to display from a range of options. 

G1–G4 
(Gx sheets) 

Graph sheets Sheets G1 and G2 show ‘Animated’ results for the Demographic 
and Economic variables respectively, while sheets G3 and G4 
display line graphs for the Demographic and Economic 
variables. In each of the graph sheets, users can select the 
desired variable from a drop-down box. 

Data for the graphs in these sheets is drawn from sheet GData. 

SMenu MoDEM 
Export/Import 
Menu 

Allows users to export or import a MoDEM scenario. Also links 
to the Results menu (RMenu) so users are able to quickly 
access results from an imported scenario. 
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Table 1.2 Additional worksheets visible in MoDEM Expert Mode 

Worksheet name Description How worksheet(s) interact with other worksheet(s) 

Validation Validation data sheet Gives plausible ranges of values for different 
parameters, such as ERP, fertility, migration and so on. 
The validation (Vx) sheets use the figures in the 
Validation sheet to suggest whether or not user input 
figures are within a plausible range. 

Processed input Contains complete 
set of data input 
necessary to 
calculate projection 
results for the active 
scenario. 

Data are organised into a series of tables on fertility, 
migration, mortality, labour force participation and so 
on. 

Data are mostly taken from the Raw input sheet. The 
major exception is mortality data. Mortality rates, 
calculated by interpolation, are taken from the applied 
mortality sheet (titled Mortality). 

Raw input Contains data input 
for the active 
scenario.  

Takes data from the Database (db_x) sheets for 
fertility, mortality, migration and so on. Feeds into the 
Processed input sheet. 

A complication is mortality data:  
• A full set of mortality figures for the active scenario 

are taken from the db_mortality sheet and put into 
Raw input ‘as is’.  

• The first column of data (i.e. data for the base year) 
only is pasted into the applied mortality sheet (titled 
Mortality). Mortality rates for years after the base 
year are calculated by a process of interpolation in 
the Mortality sheet. 

• The Processed input sheet draws mortality rates 
(calculated by interpolation) from the Mortality 
sheet. 

The Raw input sheet also contains the productivity 
growth rate and discount rate. 

Imported input Contains complete 
set of data input (from 
an imported scenario) 
needed to calculate 
projection results 

Figures are taken directly from Imported raw sheet. 

Imported raw Contains data input 
for an imported 
scenario 

When the user runs the macro to import a previously 
saved MoDEM scenario, the data are pasted as values 
into this sheet. 

Pop_estimate Contains projected 
ERP for males and 
females in every age 
group from 0 to 100 

Figures for the base year (i.e. the first column of 
figures) are taken from sheet db_Misc. 

Figures for successive years are calculated by: 
• For age group 0, taking the rounded sum of births 

and immigrants of age 0, less emigrants of age 0, 
from the sheets Births, Immigrants and 
Emigrants. 

• For other age groups, taking the rounded sum of 
survivors and immigrants, less emigrants, from the 
sheets Survivors, Immigrants and Emigrants. 

(Continued next page) 
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Table 1.2 (continued) 

Worksheet name Description How worksheet(s) interact with other worksheet(s) 

Deaths Contains the 
projected number of 
deaths by age and 
sex, from 
(baseyear + 1) 
onwards 

Figures obtained by multiplying death rates from the 
Mortality sheet by projected ERP in the Pop_estimate 
sheet. 

Births Contains the 
projected number of 
births by age of 
mother, from 
(baseyear + 1) 
onwards. 

Total births are divided into male and female births 
based on a ratio at the top of the sheet. 

Number of births by age of mother is obtained by 
multiplying fertility rates from the Fertility sheet by 
projected female population in a given age bracket 
from the Pop_estimate sheet. 

This sheet also calculates the number of surviving 
births (male and female) by multiplying the total 
number of births (male and female) by (1 – infant 
mortality rate) from the Mortality sheet. 

Survivors Contains the 
projected number of 
resident persons 
surviving in each year 
from (baseyear + 1) 
onwards, by age and 
sex 

Figures obtained by multiplying (1 – death rate) from 
the Mortality sheet by projected ERP in the 
Pop_estimate sheet. 

Immigrants Contains the 
projected number of 
immigrants by age 
and sex, from 
(baseyear + 1) 
onwards. 

Figures are taken from Processed input sheet. 

Emigrants Contains the 
projected number of 
emigrants by age and 
sex, from 
(baseyear + 1) 
onwards. 

Figures are taken from Processed input sheet. 

Sum formula Consolidates the 
active user-defined 
shocks by taking the 
sum 

Sums up the active shocks as entered in the Raw 
input sheet. 

Max formula Consolidates the 
active user-defined 
shocks by taking the 
maximum or range 

Takes the maximum (or their range, if the Max – Min 
consolidation option has been selected) of the active 
shocks as entered in the Raw input sheet. 

Average 
formula 

Consolidates the 
active user-defined 
shocks by taking the 
average 

Takes the average of the active shocks as entered in 
the Raw input sheet. 

(Continued next page) 



   

 MODEM 
WORKSHEETS 

65

 

Table 1.2 (continued) 

Worksheet name Description How worksheet(s) interact with other worksheet(s) 

Total UDS 
increments 

Shows the selected 
form of consolidation 
of user-defined 
shocks (UDS). 

Figures are taken from the Sum formula, Max 
formula or Average formula sheets according to 
which method of consolidation of shocks is selected. 
The selected method is represented by an index in the 
Total UDS increments sheet, which is linked to the 
selection stored in db_Misc. 

Mortality Contains mortality 
rates by age and sex, 
for the base year 
onwards. 

Figures for the base year are taken directly from the 
Raw input sheet. 
Figures for subsequent years are calculated by a 
process of interpolation. 

Mortality shape Describes the pattern 
of mortality across the 
projection period. 

Shows mortality rates for the base year and the ‘final 
year’ (46 years after the base year, after which 
mortality rates are static), and calculates the natural 
logarithm of the ratio of final year to base year rates. 

Fertility Contains figures on 
the age pattern of 
fertility and on the 
total fertility rate. 

Shows the age-specific fertility rate (ASFR) and total 
fertility rate (TFR). 
• The ASFR represents the number of births occurring 

in a calendar year divided by the female population 
(in thousands) in each age group. 

• The TFR, which is known as the ‘Fertility Level’ in 
the MoDEM interface (sheet DP2), represents the 
average number of births per woman over a lifetime. 

In this model, the projected TFR figures are taken 
directly from the Processed input sheet (where they 
are derived from the preset fertility scenario selected 
by the user, or the fertility level entered by the user). 
The projected ASFR figures are then calculated and 
adjusted to be consistent with the TFR figures. 

Female 
convergence 

Shows the changes in 
the over-60 female 
participation rate 
needed to achieve 
convergence with 
participation rates 
among males of the 
same age. 

The parameter sex_converge applies to the oldest age 
groups in the labour market: 60–64, 65–69 and 70+. 
When active (non-zero), this parameter represents the 
number of years over which female participation rates 
are made to converge to those of males. 
The participation increments shown in this sheet are 
calculated by combining the value of sex_converge 
with participation rates for males and females in the 
over-60 age groups from the Raw input sheet. 

Intermediate Shows additional 
participants, workers 
and hours worked 
resulting from user-
defined shocks. 

Translates shocks to participation rates, unemployment 
rates, part-time shares, full-time and part-time average 
hours into incremental participants, workers and hours. 
These calculations are explained in Appendix B of the 
User’s Guide to MoDEM. 

GDP-baseline Contains projections 
for economic and 
demographic 
parameters for the 
baseline scenario. 

Figures on this sheet are copied from the GDP sheet 
when the user chooses to set the active scenario as 
the baseline scenario. 
Any changes to the active scenario have no effect on 
the GDP-baseline sheet until the scenario is set as a 
baseline. 

(Continued next page) 
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Table 1.2 (continued) 

Worksheet name Description How worksheet(s) interact with other worksheet(s) 

GDP Contains projections 
for economic and 
demographic 
parameters for the 
active scenario. 

The input data on this sheet are mainly taken from the 
Processed input and Pop_estimate sheets. These 
data are used to calculate the economic and 
demographic projections shown in this sheet, such as 
GDP, labour force size, and aggregate productivity. 

GDP-UDS Contains projections 
for economic and 
demographic 
parameters for the 
active scenario, after 
taking into account 
the effects of user-
defined shocks. 

Input data on this sheet are taken from the from the 
Processed input, Pop_estimate and Intermediate 
sheets to calculate the economic and demographic 
projections shown in this sheet. These projections 
include the effects of user-defined shocks. 

Deviations_ 
GDP_Base 

Shows the difference 
in economic 
projections between 
the baseline and the 
active scenario. 

Figures are calculated by taking the difference 
between the equivalent value in the GDP sheet and 
that in the GDP-baseline sheet. 
These deviations are displayed in the results (Rx) 
sheets when the ‘Demographic Deviation’ option is 
selected from the drop-down menus in sheets R9–R13. 
This allows the user to easily view the effect on key 
outputs of changing from the baseline scenario to the 
active scenario. 

Deviations_ 
GDPUDS_Base 

Shows the difference 
in economic 
projections between 
the baseline and the 
active scenario with 
user-defined shocks. 

Figures are calculated by taking the difference 
between the equivalent value in the GDP-UDS sheet 
and that in the GDP-baseline sheet. 
These deviations are displayed in the results (Rx) 
sheets when the ‘Total Deviation’ option is selected 
from the drop-down menus in sheets R9–R13. This 
allows the user to easily view the effect on key outputs 
of changing from the baseline scenario to the active 
scenario (including the effects of user-defined shocks). 

Deviations_ 
GDPUDS_GDP 

Shows the difference 
in economic 
projections for the 
active scenario with 
and without the user-
defined shocks. 

Figures are calculated by taking the difference 
between the equivalent value in the GDP-UDS sheet 
and that in the GDP sheet. 
These deviations are displayed in the results (Rx) 
sheets when the ‘Labour Supply Deviation’ option is 
selected from the drop-down menus in sheets R9–R13. 
This allows the user to easily view the effect on key 
outputs of user-defined shocks within the active 
scenario. 

Deviations_Dem Shows the difference 
in demographic 
projections between 
the baseline and the 
active scenario. 

Figures are calculated by taking the difference 
between the equivalent value in the GDP sheet and 
that in the GDP-baseline sheet. 
These deviations are displayed in the results (Rx) 
sheets when the ‘Deviation’ option is selected from the 
drop-down menus in sheets R1–R8. This allows the 
user to easily view the effect on key demographic 
projections of changing from the baseline scenario to 
the active scenario. 

(Continued next page) 
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Table 1.2 (continued) 

Worksheet name Description How worksheet(s) interact with other worksheet(s) 

Gdata Contains input data 
for the graphs in 
MoDEM Results 
module. 

Data in this sheet are used as input for the graphs 
linked to the results menu (RMenu) and tables (Rx) 
sheets. 

DPGData Contains input data 
for the graphs in the 
Detailed Projection 
module. 

Data in this sheet are used as input for the graphs in 
sheets DP2 to DP15 (inclusive) in the Detailed 
Projection module. 

MenuSheet Contains items for the 
MoDEM Menu. 

Contains a list of commands included in the MoDEM 
Menu, as well as macro-launching buttons to create or 
delete the MoDEM Menu. 

db_Misc Stores miscellaneous 
information. 

The information in this sheet is organised into 30 small 
‘tables’, and is drawn from a number of sheets in 
MoDEM. It mainly consists of indices representing 
selections made by users (via drop-down boxes, forms, 
and so on). For example, the sheet includes toggle 
indicators showing which user-defined shocks are 
currently active, and what method of consolidation is 
selected. 
This sheet stores the ERP data for the base year and 
(base year – 1), which are required to define the initial 
population for the base year. It also contains the initial 
value of GDP for the base year. 

db_mortality Stores mortality rates 
for the active scenario 
as well as other 
preset and user-
defined scenarios. 

The sheet is organised as follows: 
• The top section shows the list of possible scenarios 

from which the user may select, and displays the 
scenario that is currently selected (the active 
scenario) 

• The next sections, ‘MoDEM Males’ and ‘MoDEM 
Females’, show mortality data for the active 
scenario. 

• The rest of the sheet shows data for all possible 
scenarios, as listed at the top of the db_mortality 
sheet. 

The data in this sheet, as with the other Database 
(db_x) sheets, feeds into the Raw input sheet. 

db_avhourspart Stores average part-
time hours for the 
active scenario as 
well as other preset 
and user-defined 
scenarios. 

The sheet is organised in the same way as the 
db_mortality sheet, and also feeds into the Raw input 
sheet. 

db_avhoursfull Stores average full-
time hours for the 
active scenario as 
well as other preset 
and user-defined 
scenarios. 

The sheet is organised in the same way as the 
db_mortality sheet, and also feeds into the Raw input 
sheet. 

(Continued next page) 
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Table 1.2 (continued) 

Worksheet name Description How worksheet(s) interact with other worksheet(s) 

db_ 
parttimeshare 

Stores the part-time 
work share for the 
active scenario as 
well as other preset 
and user-defined 
scenarios. 

The sheet is organised in the same way as the 
db_mortality sheet, and also feeds into the Raw input 
sheet. 

db_participation Stores participation 
rates for the active 
scenario as well as 
other preset and 
user-defined 
scenarios. 

The sheet is organised in the same way as the 
db_mortality sheet, and also feeds into the Raw input 
sheet. 

db_unemploy Stores unemployment 
rates for the active 
scenario as well as 
other preset and 
user-defined 
scenarios. 

The sheet is organised in the same way as the 
db_mortality sheet, and also feeds into the Raw input 
sheet. 

db_civil Stores civilian 
population ratios 
(ratio of civilians to 
total population in 
each age–sex group) 
for the active scenario 
as well as other 
preset and user-
defined scenarios. 

The sheet is organised in the same way as the 
db_mortality sheet, and also feeds into the Raw input 
sheet. 

db_ageprod Stores age-specific 
productivity ratios 
(relative productivity 
of workers in each 
age bracket) for the 
active scenario as 
well as other preset 
and user-defined 
scenarios. 

The sheet is organised in the same way as the 
db_mortality sheet, and also feeds into the Raw input 
sheet. 

db_Emigl Stores emigration 
level (number of 
emigrants per year) 
for the active scenario 
as well as other 
preset and user-
defined scenarios. 

The sheet is organised in the same way as the 
db_mortality sheet, and also feeds into the Raw input 
sheet. 

db_Immigl Stores immigration 
level (number of 
immigrants per year) 
for the active scenario 
as well as other 
preset and user-
defined scenarios. 

The sheet is organised in the same way as the 
db_mortality sheet, and also feeds into the Raw input 
sheet. 

(Continued next page) 
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Table 1.2 (continued) 

Worksheet name Description How worksheet(s) interact with other worksheet(s) 

db_Fertl Stores fertility level 
for the active scenario 
as well as other 
preset and user-
defined scenarios. 

Fertility level (also known as total fertility rate (TFR) in 
MoDEM) measures the average number of births per 
woman over a lifetime. 

The sheet is organised in the same way as the 
db_mortality sheet, and also feeds into the Raw input 
sheet. 

db_Fertp Stores age-specific 
fertility rates for the 
active scenario as 
well as other preset 
and user-defined 
scenarios. 

Age-specific fertility rates (ASFR) represent the 
number of births occurring in a calendar year divided 
by the female population (in thousands) in each age 
group. MoDEM uses births throughout a calendar year 
to represent the fertility pattern at June 30. 
The sheet is organised in the same way as the 
db_mortality sheet, and also feeds into the Raw input 
sheet. 

db_Immip Stores immigration 
age pattern (for males 
and females) for the 
active scenario as 
well as other preset 
and user-defined 
scenarios. 

The sheet is organised in the same way as the 
db_mortality sheet, and also feeds into the Raw input 
sheet. 

db_Emip Stores emigration age 
pattern (for males and 
females) for the 
active scenario as 
well as other preset 
and user-defined 
scenarios. 

The sheet is organised in the same way as the 
db_mortality sheet, and also feeds into the Raw input 
sheet. 

TBSheet Displays a list of 
toolbars that are 
hidden in Interface 
Mode and visible in 
Expert Mode. 

This sheet is referred to in the macros that switch the 
user between Interface Mode and Expert Mode. For 
example, when moving from Interface to Expert Mode, 
the relevant macro will proceed to ‘show’ the toolbars 
listed in TBSheet. 
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